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Caring and Sharing even more

Education is for improving the 
lives of others and for leaving 

your community and world 
better than you found it.
                                                         —Marian Wright Edelman

We all know that there is nothing more critical 
in a democracy than having all citizens take 
part, in ways both large and small, just for 

“the good of the order.”
Thanks to the foresight and generosity of the 

Orfalea Fund and the Santa Barbara Foundation, all third 
grade teachers in the county will now have resources to 
supplement their units on communities by engaging their 
students in projects that make their community a better 
place. How important, and how wonderful.

The idea of the Care & Share II Program is to 
nurture among our young people the impulse to do 
good work and help others, then channel those impulses 
into a worthy classroom project. Enabling young people 
to help design and execute 
a project that helps the community—whether the larger 
community, the school, or even the classroom—helps 
them experience the “glow” that comes from giving to 
others and improving a community.

Doing good feels good, and this project provides 
an early opportunity for young people to learn that very 
important lesson. The logistics are very simple. All 
third grade teachers in the county are eligible to receive 
$250 for projects in their classroom involving students 
with philanthropy.

The Orfalea Fund, in partnership with the Santa 
Barbara Foundation, has funded this opportunity for 
three years, so that every third grader will have the 
chance to experience the joy of caring and sharing. 

Teachers need to fill out a “Request for Funds” 
application. Funds will be available approximately two 
weeks after the request is received, and may be used 
on materials, transportation, research, and related items 
that enable the completion of the philanthropic project. 
It’s a great program and we are honored to be a central 
part of it because of the important values it represents.

Children’s Book Week

Nov. 12 to 18 is the Children’s 
Book Council’s “Children’s 

Book Week”—a great time to  
come see the wealth of books in 
SBCEO’s K-8 and preview libraries 
and find just the right one to take 
home to read with your family.         —Fred Borchers/IMS

The great book exchange

No matter what else you love to do, reading is a great 
pastime. Take a hiking guidebook out on a walk or curl 

up with a good mystery novel. And what could make reading 
better than the wonderful SBCEO book exchange?

 Here is how it works: In the break room at the 
main office on Cathedral Oaks, there are several shelves 
just brimming with books. Take a look, and if you see 
something you like, you can read it during lunch or take it 
home. When you finish, bring it back. Or not. And bring  
in old books that are collecting dust on the shelves at 
home. The beauty of the SBCEO book exchange is that 
there is really only one rule: Take some time for yourself 
and have a good read.                           —Tom Heiduk/HR



�

 Alum News:
Life after SBCEO

Mark Sawran, formerly a delivery 
driver for IMS, is now a grandpa. 

His daughter Kari had a baby boy, 
Michael. Mark is living on the big island 
in Hawaii as a supervisor of a water 
treatment plant and is enjoying the 
geography, climate, and adventures of 
our 50th state.         —Fred Borchers/IMS

***

Ever wonder what happened to Taiwo Madison? I am 
sure lots has happened, but for at least a while, it will be 

happening (again) in SBAS. Just like a blast from the past, 
Taiwo will be filling-in for a while. Welcome back!
                                                                    —Tom Heiduk/HR

***

Marilyn Wibbeler (former secretary in SBAS) is 
living in Bayfield, CO, just outside Durango, and 

is working full-time for a soil engineers company. She 
bought a house on a one-acre lot and has 50 pine trees and 
a view of the valley. Marilyn was in Santa Barbara for her 
50th high school reunion at SB High and stopped by to see 
us. She says her slower lifestyle in Colorado makes her 
very happy.                                           —Carole Cole/SBAS

by Karen Ranum/Information Technology Services

Ask us
your 

questions.

Help desk

Q  : I often send the same email response; how do I set up a  
template in Entourage or Outlook? 

A  : Entourage does not have a template option. A work-around  
is to create a new signature file for every template. 
1.	 Click on the Tools menu and select Signatures.
2.	 Click on the New button and then enter a name for the signature.
3.	 Delete the - - dashes at the top of the new signature window and  

insert your text. 
4.	 Click on the File menu and select Save. 
5.	 To place the new signature, place the cursor where you want the  

template inserted and then click on the Signatures button. 

To create a template in Outlook 2003: 
1.	 Click on the Tools menu and select Options. 
2.	 Click on the Mail Format tab and un-select: Use Microsoft Word 2003 to edit email messages. 
3.	 Create a new mail message and insert your template text. 
4.	 Click on the File menu and select Save As. 
5.	 Enter the file name of the template. 
6.	 Click on the arrow under Save as type and select Outlook Template. 
7.  To place the template into a new mail message: 
	 a.	Click File menu and select New – Choose Form. 
	 b.	In the Look In field, select User Templates in File System. 
	 c.	Select your template and then click on the Open button.

Email Templates Free download 
of the month

Macintosh 
iCal Automator provides actions to 
move events, add to-do alarms, and 
find past events. http://www.yellow-
camp.com/freebies

Windows
CCleaner speeds up your computer by 
removing unused files. Options include 
emptying the trash and clearing form 
data from Internet Explorer. 
http://www.ccleaner.com/ 
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We all miss seeing Bob Freeborn-
Rubin in the Cathedral Oaks 

mailroom. He’s in Fiscal Services now, 
in case you wondered. With that said, 
huge kudos to Doris Buchanan for 
her hard work in always keeping the 
mail moving. Always ready with an 
infectious smile, or witty remark, Doris 
helps each of us every single day. 
Thanks, Doris.         —Tom Heiduk/HR

*** 

Kudos to Robert Valenzuela in 
the North County. He is always 

happy, quick to flash a smile, and 
willing to do anything asked of him. 
He is a great handyman and can fix 
anything. I truly appreciate him and 
want to say “thank you” for doing such 
a great job and making my job easier.
  —Araceli Meridith/FitzGerald School

Students Mayra Ponce and Cathy Gonzales wait for a signature from Jane Goodall 
in the Eco-cell box at the third international Peace Day.

Lee Ann Knodel, ROP Virtual Enterprise teacher at Santa Barbara High 
School, says she cannot begin to say how thrilling and inspiring it was for 

her and for her Virtual Enterprise students to meet Jane Goodall at the Third 
Annual International Peace Day in September.

Lee Ann said, “It was an amazing day for everyone involved. Jane Goodall 
even signed our Eco-Cell box with the chimp on it, and she was not doing 
any signing, so it was a huge honor. [Goodall] loved the student designs and 
projects. The class also received a signed Certificate of Appreciation from the 
Goodall Institute. She spent several minutes with them discussing the Eco-Cell, 
recycling batteries, and the VITA Service-Learning projects. It was a proud 
moment. The event will be featured in the class’s newsletter and at the VE 
grand opening in December. 

We thank Kathy Kelly and Irene Falzone for taking us to the event. We 
were the only high school group from Santa Barbara County.” Kudos to Lee 
Ann Knodel.                                                                   —Marilyn Lake/ROP-S

ROP students meet with Jane Goodall

The Santa Barbara Service-Learning 
Initiative, active in 15 Santa Barbara 

County school districts, launched the 
second year at a large gathering of Roots 
and Shoots school clubs at Griffith Park 
in Los Angeles in September. More than 
80 teachers, students, and partners made 
the trip. The Third Annual International 
Day of Peace, which took place during 
National Learning and Service Week, 
was particularly special this year because 
Dr. Jane Goodall met with each Santa 
Barbara County teacher and student 
to review Service-Learning projects. 
Service-Learning focuses on civic 

participation and service in the local 
community while improving academic 
achievement. The Service-Learning 
projects presented were student-designed 
and integrated into classroom curriculum. 

It was a unique opportunity for 
students, educators, and the whole 
community to meet with Goodall, the  
living embodiment of service and 
learning; a world-renowned biologist, 
primatologist, and conservationist; 
as well as a UN Messenger of Peace. 
Teachers and students said this was a day 
they will never forget, and that they are 
inspired to continue their commitment to 

Educators/students meet Jane Goodall, advance service-learning efforts
Service-Learning.

The Santa Barbara County 
Service-Learning Initiative supports 
Service-Learning by building a 
network of teachers who function as 
school site advocates, implementing 
Service-Learning as a teaching strategy 
and acting as a resource to parents, 
colleagues, and community partners 
to strengthen the connection between 
learning and service. More information 
is available from Art Fisher, Service-
Learning Lead. —Marilyn Lake/ROP-S

Kudos
and

         thanks
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Y-ME spans globe

Ann Marcos and Mimi Kaplan were 
dealing with breast cancer during 

a time when the word “cancer” was 
often whispered. In 1978, convinced 
that knowledge was power when it 
came to breast cancer and that talking 
about their feelings could lessen the 
isolation of their experience, they were 
inspired to create a telephone hotline 
and support network that evolved into 
‘Y-ME.’

Y-ME provides 24/7 peer support 
information and empowerment to tens 
of thousands of women nationwide, 
ensuring that no one faces breast cancer 
alone. Also, thanks to the Internet, Y-
ME reaches people worldwide in seven 
different languages, at www.y-me.org. 
Those interested can get involved by:
•	 passing on Y-ME’s hotline number 

(800) 221-2141 to someone who 
may need information/support.

•	 becoming an advocate.

•	 holding a breast health seminar in 
your workplace, club, or religious 
institution.

•	 becoming a Y-ME hotline volunteer 
peer counselor after completing the 
training and certification program.

•	 making a gift to Y-ME in honor or 
memory of a loved one.

•	 shopping for the cause. Visit www.
y-me.org and click on Corporate 
Partners for ideas.

•	 joining the mailing list to begin 
receiving Peer to Peer, Y-ME’s 
newsletter.
—Luciana Gallegos/Migrant Ed.-N

Aurora Gutierrez, Migrant Education Regional Recruiter, 
has been an example to women dealing with the kinds of 

fears, questions, and doubts that breast cancer poses to many 
dear to us.

In 1999, Aurora was diagnosed with breast cancer. She 
had a lumpectomy and had 22 lymph nodes removed. She 
went through months of chemotherapy and radiation. Aurora 
continued working and shares that it was her family, spiritual 
friends, and work family that helped her get through the 
process. She has been in remission for seven years and believes 
that life goes on no matter what you’re served in life. Her 
strength comes from her spirituality and the ability to seek out 
the positive in any challenging situation. 

Aurora is dedicated to helping women in crisis. She 
works with people who have been diagnosed with cancer by 
volunteering in the “Reach to Recovery Program,” as well as 
other group therapy programs.

Cancer didn’t stop Aurora. In fact, it encouraged her 
desire to help others. She enrolled at Antioch University of 
Santa Barbara in 2001. She obtained her B. A. in liberal arts 
with concentration in psychology. She is currently pursuing 
her masters in psychology and hopes eventually to become a 
psychotherapist with a doctorate in psychology. She has been  
an inspiration.                     —Luciana Gallegos/Migrant Ed.-N

Aurora Gutierrez: 
Helping women in crisis

Migrant Ed. offers leadership  
training at Camp Whittier

Migrant Education students from North and South Santa 
Barbara County once again had the opportunity to work 

with professionals at the annual ‘Future Leaders of America’ 
conference and retreat at Camp Whittier in October. 

Middle school students in grades seven through 10 
attended sessions throughout the day, and some evenings, in 
order to hear and interact with guest speakers about becoming 
a leader. 

The event was led and arranged by Migrant Director 
Maria Garcia-Cacique and Program Specialist Delia Limon. 
                                                               —Marilyn Lake/ROP-S

Did you know?
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Bill Cirone
SB County Superintendent of Schools, Cathedral Oaks

Bill’s favorites: 
Community interest/soapbox topic: The health care crisis with 

California having the largest percent of uninsured children in 
the nation.

Quote or motto: “Tell me and I forget, show me and I remember, 
involve me and I understand.”

Book:  Self-Renewal by John W. Gardner.
Music:  Jazz.
Movies/TV shows:  Old Woody Allen movies.
Leisure time activities/hobbies:  Walking.
Other interesting work you’ve done:  Community organizing, 

teaching, business executive.
Hidden talents:  I’ll leave that to others to decide.
Hometown:  Brooklyn, New York—back in the days of the 

Brooklyn Dodgers.
Where did you go to school:  Providence College, NYC.
Any kids or pets:  Peter, who lives in Minnesota. 
How long have you been with SBCEO?  34 years.

Franny Girlando
Secretary III, SBAS/Cathedral Oaks

Franny’s favorites: 
Quote or motto: “Always look on the bright side of life”  

(sung á la Monty Python’s Life of Brian).
Book:  The Talisman by Stephen King.
Music:  Simon & Garfunkel; Crosby, Stills, Nash & Young.
Movies/TV shows:   Movie: You’ve Got Mail. TV Show: Grey’s 

Anatomy.
Leisure time activities/hobbies:  Addicted to audio books and 

reading. Cross-stitch and knitting.
Other interesting work you’ve done:  Had my own word pro-

cessing business. Taught 1st grade computers.
Hidden talents:  Songwriter, cello player.
Hometown:  La Crescenta.
Where did you go to school:  Chapman, Westmont, graduated 

from UCSB.
Any pets: Boston terrier (Pepper), and cockatiel (Kramer).
Any family bragging rights:  My two wonderful daughters.
How long have you been with SBCEO?  Two and a half years.

In case you don’t know, there is a TV star in 
our midst. Polo Ascencio might seem to be 

just another good-natured, friendly fellow from 
the Internal Services crew at the Cathedral 
Oaks site, but check this out—Polo is also the 
sports anchor/reporter for Univision  
(Channel 16). 

Monday through Friday, during both the  
6 p.m. and 11 p.m. broadcasts, you can see and 
hear Polo relate the sports news of the day. 
Wait, there’s more: Polo is also a columnist 
for the LA Dodgers Spanish website: www.
losdodgers.com.                  —Tom Heiduk/HR

Ester Garcia was born and raised in New 
Mexico. She currently serves as a migrant 

support staff assistant for Shandon as well 
as being responsible for recruitment in the 
Atascadero, Templeton, Pleasant Valley, 
Shandon, and San Miguel school districts.

Ester can really relate to our migrant 
families because she, too, worked in the fields. 
She picked cotton and onions; gathered eggs; 
and canned tomatoes, garlic, and mushrooms.

She also serves as a School Board Trustee 
for the Shandon Unified School District. She 
is currently serving her second four-year term. 
Her dedication to education and children’s 
safety issues is admirable.

Ester shares that as a board member, it 
was heart-warming to present her son with 
his diploma from Shandon Unified School 
District and later present her grandson with his 
diploma.  Her son is a UCLA alumnus and her 
grandson attends Santa Monica College.

Ester has a dream to one day have her own 
canning business. She hopes to can her famous 
salsas, pickled cactus, and jalapeño chiles. So, 
keep your eyes and ears open because I’m sure 
we’re going to want to try her specialty items 
that so many others in the Shandon area have 
already had the opportunity to taste.

            —Luciana Gallegos/Migrant Ed.-N

Polo Ascencio:  TV Star

Ester Garcia: Future canner
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I    am thankful for life.        
                       —Lonnie Hughes/BTSA

*** 

I am thankful for my family; I am also 
thankful for the sense of humor I 

use when dealing with them all! I am 
thankful for my work—I have been 
blessed with an exceptional supervisor 
and creative, compassionate, energetic 
co-workers. I am thankful for my 
relative health, and that of my family— 
each day is new and beautiful! I am 
thankful for grace—to deal with life’s 
trials.       
               —Jeanne Greenfield/Ed. Tech.

*** 

I    am thankful for today!
                        —Jessica Lopez/HR

*** 

I am thankful for all the great people 
that I work with and for (honest...

no, I really am...believe me!). And I’m 
thankful for Grandma Mary See’s dark 
chocolate truffles and Costco pumpkin 
pies. Happy Thanksgiving!

             —Tim Furman/IT Services

*** 

I am thankful for the chance to work 
with and learn from Sue Smith 

(FitzGerald). She is great teaching 
personified.

             —Sydney Vincent/SESS-N

*** 

I’m thankful for an alert mind, a 
good appetite, a good husband, 

fun co-workers, a good child, and for 
everything around me that is good. 
Some rain would make me even more 
thankful.         
                     —Katherine Knudsen/HR

My two daughters, and COLAs to 
help pay for them!

                —Franny Girando/SBAS

*** 

The whiteboard. Gives me a laugh 
during the day.
           —Martha Reynolds/SESS-S

*** 

My husband is active duty military. 
For the first time in a very long 

time, he will not be deployed during the 
holidays. Thank you, God! I am so very 
thankful for the sacrifices made daily 
by military members and their families. 
Being separated is hard, but during the 
holidays it’s even more difficult. So, a 
big THANK YOU to our armed forces 
and families.         
                            —Susie Ruiz/SESS-N

*** 

I am very thankful to have such a great 
family, and frankly, to have the most 

wonderful mother in the world. Also, 
I’m extremely thankful to live in Santa 
Barbara—the best hometown anyone 
could have.              —Tom Heiduk/HR

*** 

My wonderful children and family, 
good health, and an amazingly 

competent and hard-working staff here 
at ROP!          —Sheryl Malone/ROP-S

*** 

I am so thankful for my health, and for 
my friends and family that care about 

me. And most of all, for my husband 
who has stuck with me for 30 years.

                      —Peggy Greer/NoCo

*** 

I was compelled to respond to this in 
a simple way: For all the freebies 

we get from our creator, like the air, 
the sunshine, the rain, the flowers and 

trees. He’s given us all we need to be 
happy! Let’s sit down and count our 
blessings more often! Observing the 
beauty all around us—let’s be thankful 
for His love!          
                 —Maria Gomez/Migrant Ed.

*** 

I’m thankful for great supervisors and 
a healthy family!

                     —Rose Vigil/SESS-N

*** 

My dad and my mom. My son Isaac 
and daughter Rebecca. My son is 

in 5th grade and doing well in school. 
My daughter is in 4th grade and also 
is doing well in school. They go to El 
Camino School and Daddy spends a lot 
of time helping them with homework.

    —Michael Pardo/Fiscal Services

*** 

Life—every day is a gift. The sky, 
trees, flowers, air, wind, birds, 

animals, Mother Earth!
              —Lyn Gutiérrez/SESS-N

*** 

I’m thankful for my determination to 
be my best in all I do, for my family, 

and most of all, for the gift of faith I 
have to face any challenge and pass that 
on to anyone in need of guidance.

                       —Juana Rubio/JCCS

*** 

I am thankful for Dwayne “The Rock” 
Johnson. 

—Sylvia Nevarez/Child Development

*** 

For the bright sunshine and stars up 
above; For the wind and the rain and 

the trees that I love; For the mountains, 
the sky, the sea and the sand; The 
creation, so grand.           —Anonymous

What are you thankful for?
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Achieving success starts now

Virtual Enterprise students from area programs at San Marcos, 
Santa Barbara, Moorpark, San Luis Obispo, and Carpinteria high 

schools attended a morning workshop to get prepared to launch their 
Virtual Enterprise business for the 2007/08 school year. 

Steven Roche, SVP, Pacific Capital Bancorp; Dr. Julie Brown, 
Marketing Instructor, SBCC; Steven Loeffler, VP Rabobank; Lee 
Ann Knodel, ROP Instructor, Santa Barbara High School; and Mark 
Madden, VP, Sunkist Growers spoke with approximately 75 students 
about sales techniques, marketing, HR professionalism, online banking 
simulation, and being a CEO. 

The Virtual Enterprise students will use this helpful training and 
education to compete at the Ninth Annual Virtual Enterprise Trade Fair 
in Bakersfield on Nov. 28 and 29. Additional trade fair competitions 
may include New York City, San Francisco, Virginia Beach, or 
Charleston. The event was coordinated by Marilyn Lake, Regional 
Occupational Program.                                      —Marilyn Lake/ROP-S

The recycling of cell phones minimizes the mining process of 
the resources needed for cell phones. ROP Virtual Enterprise 

students at Santa Barbara High are being pro-active in helping save 
the environment and the habitat of wild animals. The program, 
called ‘Eco-Cell,’ collects old cell phones from local businesses, the 
education community, friends, and family to help reduce the mining 
needs. Last year, 245 cell phones and 200 pounds of batteries were 
recycled. ROP students have placed recycle boxes at the Cathedral 
Oaks site in the Educational Technology Training Center and  in the 
employee lounge. Let’s fill them up. More information is available  
by contacting Lee Ann Knodel at 963-8597 or Marilyn Lake at  
ext. 4406.                                                         —Marilyn Lake/ROP-S

Eco-Cell program helps save environment

Oh, baby!

A 
riana Alexis Louise Valadez was born 

Monday, Sept. 24. She weighed 8 lbs., 7 oz.; 
and was 20-inches long. We are both doing 
well. Please pass on our family’s happy 
news.          —Patty Valadez/Fiscal Services

***

C 
heryl Zuniga, Center for Community 

Education, is the proud new grandmother 

of Brody Michael Green. Brody was 
born on Tuesday, Sept. 25, weighing 
8 lbs., 10 oz., measuring 21 inches 
long. He joins big sister, Riley Marie, 
and parents, Teri and Donovan 
Green, at home. Brody is Cheryl’s 
third grandson, but 4th grandchild.                                                                                         
                          —Marilyn Lake/ROP-S

Welcome to the  
following employees:

Special Education
Gloria Chavez  
Instructional Assistant,  
Santa Barbara

Cathy Porter  
School Occupational Therapist, 
Santa Maria

Jenifer Sautot 
Instructional Assistant, Cold Spring 
Elementary School, Montecito

Donna Whitman 
Special Day Class Teacher,  
Santa Maria 
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Answers to last  
month’s puzzle:

Each word is an 
anagram of an  

one-word movie title 
that won at least one 
Oscar: 
ashen – Shane;  
copiers – Serpico;  
inane – Annie; 
hustle – Sleuth; 
chars – Crash;  
mentors – Monster;  
ail – Ali; 
bantam – Batman;   
abort – Borat;  
saline – Aliens.

Are you a surfer? Do your children surf? Come take 
a look at and preview a beautifully-illustrated 

and well-written picture book biography of Duke 
Kahanamoku called Surfer of the Century by Lee & 
Low Books in our preview library. The book is filled 
with details of Kahanamoku’s boyhood in Honolulu, 
with the Pacific Ocean as his backyard, as well as his 
struggle with racism and financial troubles throughout 
his 20-year Olympic career. Ellie Crowe’s words are 
sparse but informative and Richard Waldrep’s gouache 
with colored pencil illustrations capture Kahanamoku’s 
competitive spirit, determination, and humanity.

                                          —Fred Borchers/IMS

Migrant Education staff celebrate

Migrant Education staff recently attended a three-day regional 
retreat where “celebration” was the theme. In planning for 

the school year, staff recalled the many educational programs and 
activities that took place during the last year and the impact made 
upon migrant children and their parents. It was unanimous that there 
were reasons to celebrate both accomplishments and “work family.” 
Each member is hard working—continuously proving dedication and 
support for the families they serve.  

The presenters were impressive. Martha Chavez demonstrated 
valuable cooperative strategies for evaluating programs by “TEAM” 
effort. She emphasized, “I must be happy with me, before I can make 
someone else happy;” and “Don’t live by saying some day, instead 
strive to say, I will. Tomorrow is not promised.”

Marta Serna and Nancy Therman shared strategies for working 
with English Language Learners in the classroom in the areas 
of English and mathematics. There were great examples of how 
children learn and how they can “feel” in the process. 

Manuel Unzueta impressed upon the participants the importance 
of cultural awareness and the value of sharing our stories of 
childhood with our own children.

Thanks to the leadership of Bill Cirone, Jan Clevenger, and 
Maria Garcia-Cacique.              —Luciana Gallegos/Migrant Ed.-N

K.I.T.
Keeping in Touch is produced and distributed  
monthly during the school year by the Public  
Information Office, Wendy Shelton, editor;  
Tracey Beauchamp, asst. editor; Olga Aguilar,  
graphic designer; and the efforts of the entire  
Reprographics staff. Many thanks to our  
contributing reporters from each department:

Fred Borchers, Instructional Media Services
Alex Calangan, Special Education – North
Terri Carbajal, FitzGerald Community School
Zonia Chaney, Categorical and Special Programs
Carole Cole, School Business Advisory Services
Jeni Fraas, Juvenile Court & Community Schools 
Bob Freeborn-Rubin, Fiscal Services
Luciana Gallegos, Migrant Education – North  
Joan Gilmore, Communications
Peggy Greer, North County Liaison Office
Tom Heiduk, Human Resources 
Marilyn Lake, ROP – South
Michael Pardo, Fiscal Services
Karen Ranum, Information Technology Services
Donna Scott, North County Liaison Office
Lillian Tolbert, Special Education – South
Mary Ann Wilkerson, Superintendent’s Office
Jeri Wynn, ROP – North

“Surfer of the Century”

by Fred Borchers/IMS

“Boys of Summer”


